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CHƯƠNG 1: LAYOUT VÀ IN ẤN  

 Mục tiêu: giúp người học sử dụng các tính năng cơ bản của layout để sắp xếp 

và in ấn các hình vẽ khác nhau trong một bản vẽ theo các tỉ lệ khác nhau. Đồng thời 

người học có thể thiết lập được các tùy biến khi in ấn, để in ấn bản vẽ đúng qui định. 

1.1. Làm việc với Layout.  

1.1.1. Không gian giấy (Paper Space). 

Khái niệm cơ bản về vùng nhìn tĩnh và động: 
Vùng nhìn tĩnh (Tiled Viewport): 
AutoCad cho phép bạn chia màn hình thành nhiều hình chữ nhật. Bạn có thể 

hiển thị các vùng nhìn khác nhau của bản vẽ trên các hình chữ nhật đó. Mục đích 
phục vụ cho việc quan sát bản vẽ một cách dễ dàng hơn. Vùng nhìn tĩnh chỉ có 
trong Model Space (MS). Một số đặc tính của vùng nhìn tĩnh (TV): 

  Một số đặc tính của vùng nhìn tĩnh (TV): 
 

sắp sếp cạnh nhau và phủ kín toàn màn hình 
 khung nhìn Active. Khung nhìn Active luôn 

có viền đậm 
  
 

nhìn 
 

sẽ đƣợc thể hiện trên các khung nhìn còn lại. 
  
 

nhìn khác. 
 ho 

mục đích khôi phục lại các khung nhìn nếu muốn. 

 Vùng nhìn động (Floating Viewport): 

 Vùng nhìn động chỉ có trong Paper Sapce (PS), bạn chỉ sử dụng nó khi muốn thể 

hiện một vùng của bản vẽ trên MS trong PS. Theo mặc đinh, chỉ có một Floating view 

(FV) trong một PS. Tuy nhiên bạn có thể tạo ra nhiều hơn một nếu bạn muốn. 

Vùng nhìn động (FV) có một số đặc tính sau 

  

move và stretch nó. Bạn có thể hiển thị nó trên layer riêng biệt, và còn có thể bật tắt 

chế độ hiển thị đƣờng bao của nó. Chúng không điền đầy màn hình nhƣ TV mà bạn 

có thể tự do thiết kế kích thƣớc và vị trí của chúng. 

  

 ong từng FV 

  

 

PS chỉ tồn tại trên PS, không tồn tại trên bản vẽ khi bạn trở về MS. 

 vẽ xong trong MS, bạn chuyển sang PS để vẽ. Trên không gian 

PS bạn có thể vẽ thêm or chỉnh sửa các Object trên MS bằng cách Double click vào 

FV. Khi đó FV làm việc giống hệt nhƣ TV. 

 Khái niệm : Tab Layout cho phép truy suất đến 1 vùng đƣợc gọi là Paper space. 

Trong paper space (PS), bạn có thể chèn title block, tạo các layout viewport, 

dimension và thêm các notes trƣớc khi in bản vẽ. 
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 PS và MS là 2 không gian làm việc riêng lẻ. Trong PS ta có thể tham chiếu đến 1 

hoặc nhiều vùng của MS với các tỉ lệ khác nhau thông qua các cửa sổ (viewport). 

 Mục đích : Ngƣời ta thƣờng sử dụng PS trong trƣờng hợp 

  

 

trúc). 

 

đƣờng) 

 

 Các bước: 

 . 

  

 Các thao tác với PS Trong PS bạn cũng có thể view, edit các PS Object nhƣ 

layout viewport và tile block. 

Mặc định của CAD, một bản vẽ có 2 layout tab, có tên là Layout1 và layout2. 

Tuy nhiên nó sẽ có tên khác nếu bạn sử dụng các template khác. 

 Bạn có thể tạo một layout bằng các cách sau : 

 • Add new layout without setting sau đó sẽ thiết lập các thông số cho nó sau. 

 • Sử dụng chức năng Creat layout wizard và thiết lập ngay các thông số cho nó. 

 • Import layout từ một bản vẽ có sẵn (DWG or DWT). 

 Add a new Layout 

 • Click insert menu → Layout → New Layout. 

 • Enter the name of the new layout on the command line. 

 • A new layout tab is created. To switch to the new layout, choose the layout 

tab. 

 To import a layout from a template 

 • Click Insert menu → Layout → Layout from Template. 

 • In the Select File dialog box, select a DWT or DWG file to import a layout 

from → Click Open. 

 • In the Insert Layout(s) dialog box, select a layout to import. 

 • A new layout tab is created. To switch to the new layout, click the layout tab. 

To create a layout using a wizard 

 • Click Insert menu → Layout → Layout Wizard. 

 • On each page of the Create Layout wizard, select the appropriate settings for 

the new layout. 

 Trong PS, Bạn cũng có thể: 

 • Duplicate a layout 

 • Rename a layout 

 • Delete a layout 

 • Rearrange layout tabs 

 • Make a layout current 

 • Sctivate the previous layout 

 • Click Select All Layouts. 

 • Plot a layout 

 

1.1.2. Các thao tác trên Viewport. 

1.1.2.1.  Tạo các Viewport. 
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 Đầu tiên bạn chuyển sang Paper Space, sau đó dùng lệnh MVIEW. 

 Trong Layout, bạn có thể tạo nhiều cửa sổ Viewport khác nhau, bạn có thể bố trí, 

sắp xếp các viewport theo mục đích của bạn. Theo mặc định, Autocad cho phép bạn 

tạo tối đa là 64 viewports , ta có thể thay đổi số lƣợng viewport bằng cách thay đổi 

biến hệ thống MAXACTVP. 

 Trong Viewport ta cũng có thể vẽ các đối tƣợng bản vẽ nhƣ trong Model space. 

Ngoài ra ta còn có thể tham chiếu đến một vùng bản vẽ nào đó của Model Space với 

một tỉ lệ đặt sẵn. Để tham chiếu đến một vùng náo đó của Model Space ta dùng lệnh 

MSPACE sau đó chọn viewport mà tat ham cần hiệu chỉnh. 

 Sử dụng chức năng zoom để đặt bản vẽ trong Model Space vào Paper Space với 

tỉ lệ nhƣ mong muốn. Tại đây ta cũng có thể chỉnh sửa, thêm bớt các đối tƣợng của mô 

trƣờng Model Space. Các thay đổi này sẽ đƣợc ghi lại trong Model Space. 

 Để quay về môi trƣờng Paper Space ta đánh lệnh PSpace. 

1.1.2.2.  Cắt xén đường bao Viewport. 
 Autocad cho phép bạn cắt xén các đƣờng biên của viewport để phục vụ cho các 

mục đích riêng của bạn. Lệnh Vclip cho phép bạn cắt xén thep một hình chữ nhật hay 

polygon bất kỳ. Cú pháp nhƣ sau : 

 Tại dòng lệnh đánh vpclip. 

 • Select the viewport to clip : chọn viewport cần cắt xén. 

 • Enter d (Delete) to delete the clipping boundary : nhấn D để xóa đƣờng biến 

đã cắt xén trƣớc đó. 

 • Enter p (Polygonal) : nhấn P để tạo đƣờng biên đa giác cắt xén mới. 

 • Specify points, or select the object, to define the new viewport boundary. 

 • Shortcut menu Select the viewport to clip, right-click in the drawing area, and 

then choose Viewport Clip. 

1.1.2.3.  Tỉ lệ cho từng Viewport. 

 Bạn có thể đặt tỉ lệ trong từng viewport bằng lệnh zoom nhƣ đã nói ở trên, tuy 

nhiên đặt với một tỉ lệ chính xác bằng cách thay đổi tỷ lệ của viewport trong cửa sổ 

Propertier (Ctrl_1). 

 Ví dụ: giả sử tỷ lệ vẽ trong bản vẽ là 1 : 25, ta đặt trong Misc/Custom : 0.04. Nếu 

muốn cố định tỷ lệ cũng nhƣ khung nhìn, bạn chuyển lựa chọn Display locked (hình 

1.1) 

 

 

 

 

 

 

 

 

 

 

 

 
  Hình 1.1. Ví dụ 

 

1.1.2.4.  Layer cho từng Viewport. 
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 Layer có thể ẩn hiện trong từng Viewport khác nhau là khác nhau. Một số tính 

năng về Layer trong Viewport thể hiện nhƣ hình 1.2.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Hình 1.2. Các tính năng của Layer trong Viewport. 

 

 Cột thứ 4 (Freeze): có chức năng đóng (tan) băng cho 

tất cả các viewport. 

 Cột thứ 12 (Freeze Viewport): có chức năng đóng (tan) 

băng cho từng viewport. 

 Cột thứ 13 (Freeze Viewport): có chức năng đóng (tan) 

băng cho tất cả các viewport mới sắp đƣợc tạo. 

1.1.2.5.  Ẩn hiện Viewport. 

 Ẩn hiện Viewport phụ thuộc vào trạng thái thông số On trong thẻ Misc của cửa 

sổ Properties khi ta chọn đƣờng bao của cửa sổ Viewport (hình3).                                               
Hình 3. Ẩn hiện Viewport 

 

1.1.2.6.  Ẩn hiện đường bao Viewport.  
 Để ẩn hiện đƣờng bao của các viewport, bạn tạo ra một layer mới chứa đƣờng 

bao của viewport mà bạn muốn ẩn hiện nó. Sau đó, việc ẩn hiện đƣờng bao sẽ phụ 

thuộc vào trạng thái bật tắt của layer chứa đƣờng bao. 

1.1.2.7.  Tỉ lệ Line Style.  
 Quản lý tỷ lệ Line Style trong Paper Space thông qua biến hệ thống Psltscale. 

 • PsLtScale = 1 : tỷ lệ dạng đƣờng sẽ đƣợc nhân với tỉ lệ phóng của viewport. 

 • PsLtScale = 0 : tỷ lệ dạng đƣờng sẽ đƣợc giữ nguyên nhƣ trong Model Space 

cho dù bạn có phóng in ở tỉ lệ bao nhiêu đi chăng nữa (hình 1.4). 
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  Hình 1.4. Tỉ lệ Line Style khác nhau 
 

1.1.2.8.  In nhiều tỉ lệ trong một bản vẽ 
 • Đầu tiên tạo các Dim cơ bản. Các Dimstyle khác sẽ đƣợc tạo dựa trên Dimstyle 

cơ bản ban đầu, bằng cách thay đổi Use overall scale of (hình 1.5). 

 

 

 

 
 

Hình 1.5. Thay đổi Use overall scale of 
 • Cần chú ý khi đo kích thƣớc, khoảng cách từ dim đến đối tƣợng dim phải phù 

hợp với tỷ lệ in của đối tƣợng đó. 

 • Các thiết lập Page setup giống nhƣ trong Plot (xem phần sau). 

 Kết luận: Nhìn chung, đối với bản vẽ cần in ấn với tỷ lệ tuyệt đối chính xác, các 

bản vẽ kiến trúc cần cắt xén khung nhìn thì nên dùng Paper space. Còn đối với bản vẽ 

bình thƣờng thì không cần vẽ trên Paper Space 

1.2. Điều khiển in ấn:  

 Trong các công ty nhỏ, sau khi đã hoàn thành bản vẽ, ngƣời ta để nguyên cả bản 

vẽ mang ra quán in và thống nhất với quán in các nét in. 

 Trong các công ty lớn hơn, sau khi hoàn thành bản vẽ, ngƣời ta sẽ quy định 

đƣờng nét in. Để thống nhất đƣờng nét in, ngƣời ta sẽ tạo ra một file có đuôi là *.ctb 

nằm trong thƣ mục C:\Documents and Settings\User\Application 

Data\Autodesk\AutoCAD 2006\R16.2\enu\PlotStyles, sau đó sẽ lƣu file này lại và 

copy cho tất cả mọi thành viên trong công ty. (file này ta sẽ nghiên cứu kỹ hơn ở phần 

sau) 

 Đối với các công ty có quy mô lớn, nhiều bộ môn chung một xƣởng in. Ngƣời ta 

sẽ in bản vẽ ra dƣới dạng file có đuôi *.PLT. File này có thể in ở bất kỳ mày in nào mà 

không cần đến phần mềm AutoCad. Nó tƣơng tự nhƣ khi ta chuyển các file văn bản 

sang *.PDF để in ấn. Đối với các loại file này, ta không cần quan tâm đến font, đƣờng 

nét. Vì đuờng nét đã đƣợc đặt khi ra in ra file. 

 Để in ấn vào menu File/Plot hoặc nhấn tổ hợp phím tắt (Ctrl P). Hộp thoại Plot 

hiện ra nhƣ hình 1.6. 

   Trong mục Page setup/name là tên của Page setup. Bạn có thể import Page setup 

từ các bản vẽ khác. Page setup đƣợc lƣu cùng với file dwg. Sau khi bạn khai báo xong 

tất cả các thông số bên dƣới, bạn ấn vào Command box “Add” để thêm một Page 

setup vào trong bản vẽ của bạn. 

 Chọn máy in trong mục Printer/plot. 

 Chọn kích khổ giấy ở Paper size. 

 Chọn vùn in trong Plot area , sẽ có 3 lựa chọn nhƣ hình bên, tùy theo mục đích 

sử dụng của ngƣời in. 

 • Display : vùng in là cửa sổ hiện hành của bản vẽ. 

 • Extents : vùng in là cả bản vẽ. 

 • Limits : vùng in là vùng limits của bản vẽ 

 • Window : vùng in là một cửa sổ mà bạn sẽ định nghĩa sau đó. 

 Điều chỉnh lề của giấy in trong Plot offset (origin set to printable area) 

 Xem trƣớc khi in trong mục Preview. 



 

 

8 

 Điều chỉnh tỉ lệ in trong Plot Scale. 

 Điều chỉnh hƣớng in (giấy nằm ngang hay thẳng đứng) trong mục Drawing 

orientation. 

 Điều chỉnh in ấn trong mô hình 3D 

 • As displayed : nhƣ hiển thị trên màn hình. 

 • Wireframe : theo mô hình khung dây (hiển thị đƣờng bao của đối tƣợng) 

 • Hiden : bỏ qua những đối tƣợng, những đƣờng bao bị che khuất bởi một đối 

tƣợng khác. 

 • Rendered : render tất cả các Object trƣớc khi xuất bản. 

 Điều khiển nét in. Đây là phần quan trọng nhất. 

 Ví dụ chọn kiểu nét in : A4.INKIEM.CTB. các file này đƣợc lƣu trong thƣ mục 

 C:\Documents and Settings\User\Application Data\Autodesk\AutoCAD...  

...\R16.2\enu\Plot Styles. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 1.6. Hộp thoại Plot 
  

 

 

Ý nghĩa của một số kiểu in sẵn có (hình 1.7) 
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Hình 1.7. Ý nghĩa một số kiểu in sẵn có 
 Để tạo mới in chọn New. Hộp thoại New xuất hiện. Chọn Start from scartch. 

 

 Hình 1.8. Tạo mới kiểu in 
  

 Máy sẽ tạo ra file test.ctb. Bấm vào nút Plot style table editor để hiệu chỉnh nét 

in. Nếu không in màu thì chuyển tất cả sang màu đen (hình 1.9) 

 
Hình 1.9. Khai báo in ấn 
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CHƯƠNG 2: MỘT SỐ LỆNH NÂNG CAO 

Mục tiêu: giúp người học sử dụng thêm một số lệnh vẽ và hiệu chỉnh có tính chất nâng 

cao. Đồng thời người học tạo và hiệu chỉnh được các block có thuộc tính để tạo các 

block có các tính năng đi kèm . 

2.1. Các lệnh về Text:  

2.1.1. Ghi Text trên cung tròn 

 Lệnh Arc – Aligned Text dùng để ghi dòng text trên một cung tròn cho 

trƣớc. Trình tự thực hiện lệnh nhƣ sau: 

- Gọi lệnh từ menu Express nhƣ hình 2.1 
 

 
 

Hình 2.1. Gọi lệnh Arc – Aligned Text 

 

- Chọn cung tròn cần thể hiện. 

 - Khai báo các thông số vào hộp thoại ArcAlignedText Workshop – Create 

nhƣ hình 2.2. 

 
 

Hình 2.2. Hộp thoại ArcAlignedText Workshop – Create 

- Cuối cùng đƣợc kết quả ví dụ nhƣ hình 2.3. 
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Hình 2.3. Kết quả ví dụ ghi text theo cung tròn 

2.1.2. Một số lệnh hiệu chỉnh nhanh Text. 

 Một số lệnh hiệu chỉnh nhanh về Text chƣa trong menu Express (hình 2.4) 
 

 
 

Hình 2.4. Một số lệnh hiệu chỉnh nhanh Text  
 

- Text Fit: co, dãn dòng Text theo trong một phạm vi nhất định (xem ví dụ 

hình 2.5) 

- Rotate Text: quay dòng Text theo một góc (xem ví dụ hình 2.5) 

- Change Text Case: chuyển đổi định dạng Text (xem ví dụ hình 2.7) 

- Convert Text to Mtext: chuyển Text thành Mtext 
 

 

 

        sau khi Fit Text                    

 

Hình 2.5. Ví dụ lệnh Text Fit  
 

      sau khi Rotate Text         
 

Hình 2.6. Ví dụ lệnh Rotate Text  
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Hình 2.7. Ví dụ đổi chữ thường thành chữ hoa  
 

2.2. Một số lệnh vẽ và hiệu chỉnh nâng cao:  

2.2.1. Lệnh vẽ đa tuyến và miền Boundary. 

Command: Boundary  (hoặc từ Draw menu chọn Boundary …) 

Xuất hiện hộp thƣ thoại Boundary Creation. Trên hộp thoại này ta chọn 

nút Pick Point và chọn điểm P1 trên dòng nhắc: 

Select internal point: (Chọn điểm P1) 

Kết thúc lệnh Boundary và thực hiện lệnh Copy ta thu đƣợc đa tuyến kín 

có hình dạng nhƣ hình 2.8 

 

a) Boundary                                   b) Sau khi Copy hoặc Move 

 

Hình 2.7. Tạo hình hình học bằng lệnh Boundary  
 

2.2.2. Lệnh vẽ đoạn thẳng có chiều rộng Trace 

 

Menu bar Nhập lệnh Toolbars 

 Trace Trace 
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Lệnh Trace vẽ đoạn thẳng có chiều rộng định trƣớc (Hình 2.9) 

 P2 P4 P1 

 

 

 

 P1 P3 P2                          P3 

                               

 

 

 

  a) Width = 5                                               b) Width = 20 
Hình 2.9. Trace với chiều rộng 

 

Command: Trace   

Specify trace width <1.000>: (Nhập chiều rộng đoạn thẳng) 

Specify start point: (Nhập tọa độ điểm bắt đầu) 

Specify next point: (Nhập tọa độ điểm cuối đoạn thẳng) 

Specify next point: (Tiếp tục nhập tọa độ điểm hoặc nhấn Enter để kết thúc lệnh) 

AutoCAD lƣu chiều rộng của Trace bằng biến Tracewid. 
 

2.2.3. Lệnh vẽ phát họa Sketch 

Menu bar Nhập lệnh Toolbars 

 Sketch  

 

Sử dụng lệnh Sketch để vẽ phát thảo bằng tay. Khi vẽ sẽ thể hiện lên các 

đoạn thẳng ngắn liên tục theo sự di chuyển của con chạy. Các đoạn thẳng ngắn 

là các đối tƣợng đơn. Khi sử dụng lệnh Sketch để vẽ thì dung lƣợng file bản vẽ 

rất lớn. 

Trƣớc khi vẽ phác thảo bằng lệnh Sketch bạn phải kiểm tra biến hệ thống 

CELTYPE để biết chắc rằng dạng đƣờng hiện hành là BYLAYER. Nếu các bạn 

dùng các dạng đƣờng không liên tục nhƣ: CENTER, HIDDEN... và nếu phân 

đoạn đƣờng sketch nhỏ hơn khoảng trống của dạng đƣờng thì bạn sẽ không thấy 

các khoảng trống này. 

Command: Sketch 

Record inncrement <1.000>: (Nhập giá trị bƣớc tăng mỗi đoạn thẳng 

đƣợc vẽ, hoặc chọn hai điểm định khoảng tăng) 

Sketch. Pen  eXit Quit Record Erase Connect. (Nhập chữ hoa của các lựa 

chọn) 

Các lựa chọn 

Record increment:  

Quyết định độ mịn của hình đƣợc vẽ, giá trị mặc định là 1.0000. Tùy vào 

giới hạn bản vẽ mà ta thay đổi giá trị này (Hình 2.10 a,b). Giá trị này càng nhỏ 

thì dung lƣợng file càng lớn. Khi vẽ bằng lệnh Sketch thì SNAP và ORTHO 

phải ở trạng thái OFF, nếu không thì hình vẽ sẽ có dạng bậc thang (Hình 2.10c) 

Sketch options: 



 

 

14 

Pen: Khi Pen down thì bút đang hạ xuống và ta có thể kéo con rê con chạy 

để vẽ, khi Pen up thì bút nâng lên và ta kết thúc quá trình vẽ. Để chuyển từ Pen 

down sang Pen up hoặc ngƣợc lại thì ta nhấp phím trái chuột. 

 Record: Lƣu tất cả các đƣờng vẽ phác thảo tạm thời trƣớc đó thành các 

đƣờng cố định, không thay đổi trạng thái của bút (up hoặc down). Sau khi lƣu 

các đƣờng này không thể hiệu chỉnh  với các lựa chọn của lệnh Skecth. 

  eXit: Lƣu tất cả các đƣờng tạm đã vẽ và thoát ra khỏi lệnh Sketch. Nhấn 

thanh ngang (Space bar) hoặc ENTER có tác dụng tƣơng tự. AutoCAD thông 

báo số đoạn thẳng thêm vào bản vẽ (hoặc số phân đoạn đa tuyến nếu biến 

SKPOLY = 1) 

  Quit: Cho phép thoát khỏi lệnh Sketch và hủy bỏ tất cả các đƣờng tạm đã 

vẽ. 

  Erase: Cho phép xóa một cách chọn lọc từ vị trí bất kỳ của đƣờng cho 

đến cuối (không xóa đƣợc các đƣờng đã Record). 

  Connect: Cho phép nối các đƣờng vẽ phác thảo sau khi bạn đã nâng bút. 

Dòng nhắc sau sẽ xuất hiện: 

Connect: Move to endpoint of line 

Ta có thể kết thúc connect bằng cách nhập C một lần nữa. 

Vẽ một đoạn thẳng (nhƣ lệnh Line) từ điểm cuối của lệnh Sketch. Sau khi 

vẽ xong thì bút sẽ đƣợc tự động nâng lên. 
 

 
 

Hình 2.10. Sử dụng lệnh Sketch để vẽ phác thảo 
 

2.2.4. Lệnh hiệu chỉnh đa tuyến Pedit 

Command: Pedit (Pe) 

Select polyline or [Mutiple]: chọn đa tuyến cần hiệu chỉnh 

- Lựa chọn: Mutiple cho phép chọn nhiều đối tƣợng 

- Nếu đối tƣợng là đoạn thẳng hoặc cung tròn không phải là đa tuyến thì 

dòng nhắc sau xuất hiện: 

 Object select is not a polyline  
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 Do you want it turn into one? <y>: bạn muốn chuyển đối tƣợng đã chọn 

thành đa tuyến không. Nhấn Enter để chuyển thành đa tuyến. 

 Sau đó sẽ xuất hiện dòng nhắc hiệu chỉnh đa tuyến. 

 Enter an option [ Close/Join/Wdith/.../Undo]: chọn lựa chọn hoặc nhấn 

Enter kết thúc lệnh. 

Các lựa chọn: 

- Close (Open): đóng đa tuyến đang mở (hoặc mở đa tuyến đang đóng) 
 

 
 Hình 2.11. Ví dụ đổi chữ thường thành chữ hoa  

- Join: nối các đoạn thẳng, cung tròn hoặc đa tuyến khác với đa tuyến 

đƣợc chọn thành một đa tuyến chung. 

 
 

Hình 2.12. Nối đa tuyến 

 

- Width: định chiều rộng mới cho đa tuyến. Sau khi nhập W sẽ xuất hiện 

dòng nhắc sau: 

Specify new width for all segment: nhập chiều rộng mới cho đa tuyến 
 

 
Hình 2.13. Thay đổi chiều rộng đa tuyến 

- Fit: chuyển đa tuyến thành một đƣờng cong là tập hợp các cung tròn, 

các cung tròn này tiếp xúc với nhau và đi qua các đỉnh của đa tuyến. 
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Hình 2.14. Lựa chọn Fit 

- Spline: chuyển đa tuyến thành một đƣờng cong đi qua điểm đầu của đa 

tuyến (nếu đƣờng cong hở). Đƣờng cong này khác với đƣờng cong tạo bởi lựa 

chọn Fit và khác với đƣờng spline tạo bởi lệnh Spline. 

 
 

Hình 2.15. So sánh đường cong Fit và Spline 

Để làm xuất hiện các đƣờng bao của đa tuyến ta định biến SPLFRAME là 

ON. 

 
Hình 2.16. Biến SPLFRAME = On 

 

Biến SPLINESEGS  qui định các phân đoạn của mỗi đoạn Spline. Hình ví 

dụ bên dƣới là các đƣờng cong B-spline bậc 2 với các giá trị biến SPLINESEGS 

khác nhau. 
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Hình 2.17. Đường cong B-spline với các giá trị SPLINESEGS khác nhau. 

 

- Decurve: chuyển các phân đoạn là các cung tròn của đa tuyến thành các 

phân đoạn thẳng. 

 

Hình 2.18. Nén thẳng các phân đoạn cung tròn đa tuyến. 

 

- Undo: hủy một lựa chọn vừa thực hiện. 

- eXit: kết thúc lệnh Pedit. 

2.2.5. Lệnh thay đổi Change. 

Lệnh Change cho phép ta thay đổi vị trí đỉnh của đoạn thẳng, bán kính 

đƣờng tròn, tính chất của Text... 

Command: Change 

- Thay đổi vị trí đỉnh của đoạn thẳng 

 
Hình 2.19. Lệnh change thay đổi đỉnh của đoạn thẳng 
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- Thay đổi bán kính đƣờng tròn 

 
Hình 2.20. Lệnh change thay đổi bán kính đường tròn 

 

Hình 2.21. Thay đổi bán kính nhiều đường tròn 
 

2.2.6. Hiệu chỉnh đối tƣợng bằng Properties Palette. 

 
Menu bar Nhập lệnh Toolbars 

Modify>Properties… hoặc 

Tools>Palette>Properties 

Properties hoặc 

Ctrl+I 

Standard 

 

Phím tắt: Ctrl+1 

Shortcut menu: Chọn các đối tƣợng mà các tính chất của nó bạn muốn 

quan sát hoặc hiệu chỉnh, nhấp phím phải chuột trên vùng đồ họa và chọn 

Properties 

Để điều kiển tính chất của các đối tƣợng sẵn có ta có thể sử dụng 

Properties Palette 

Command: Properties   

AutoCAD hiển thị Properties Palette. Properties Palette (hình 2.22) là 

phƣơng pháp chính để quan sát và hiệu chỉnh các tính chất của đối tƣợng 

AutoCAD. Ta còn có thể quan sát hoặc hiệu chỉnh tính chất các đối tƣợng thuộc 

phần mềm ứng dụng thứ ba mà các đối tƣợng của chúng dựa trên cơ sở tiêu 

chuẩn AutoCAD API. 
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Hình 2.22. Properties Palette 

Các tính chất cơ bản của một đối tƣợng AutoCAD 

Color: Chỉ rõ màu của đối tƣợng. Chọn màu trên hộp thoại Select Color 

Layer: Chỉ rõ lớp hiện hành của đối tƣợng. Trên danh sách liệt kê tất cả 

các lớp trên bản vẽ hiện hành. 

Linetype: Chỉ rõ dạng đƣờng hiện hành đối tƣợng. Trên danh sách liệt kê 

tất cả các dạng đƣờng của bản vẽ hiện hành. 

Linetype Scale: Chỉ rõ hệ số tỉ lệ dạng đƣờng cho đối tƣợng. 

Plot Stype: Liệt kê các kiểu in: NORMAL, BYLAYER, BYBLOCK cùng 

với các kiểu in bất kỳ chứa trên bản kiểu in hiện hành. 

Lineweight: Chỉ rõ chiều rộng in của đối tƣợng. Danh sách trình bày tất cả 

các chiều rộng nét in có thể chọ trên bản vẽ hiện hành. 

Hyperlink: Gắn siêu liên kết cho đối tƣợng đồ họa. Nếu dòng mô tả đã 

đƣợc gán cho siêu liên kết thì nó sẽ hiể thị. Nếu không có dòng mô tả nào đƣợc 

gán thì ULR đƣợc hiển thị. 

Thickness: Gán độ dày 3D soild hiện hành. Tính chất này không gán cho 

tất cả các đối tƣợng. 

Tất cả các tính chất khác, đã đƣợc chỉ rõ theo dạng của đối tƣợng 

AutoCAD, đều đƣợc chon theo window khác nhau. 

Khi nhập Properties tại dòng lệnh, AutoCAD hiển thị Properties Palette 

(Hình 2.22). Khi chọn một hoặc nhiều đối tƣợng thì Properties Palette liệt kê các 

thiết lập hiện hành cho tất cả tính chất đối tƣợng. Ta sử dụng Properties Palette 

để hiệu chỉnh bất kỳ tính chất nào có thể thay đổi đƣợc của đối tƣợng. Sau khi 

chọn đối tƣợng cần hiệu chỉnh, ta thực hiện một trong các cách sau để thay đổi 

gía trị tính chất của nó trên Properties Palette: 

+ Nhập giá trị mới 
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+ Chọn giá trị từ danh sách sẵn có 

+ Thay đổi giá trị tính chất trên hộp thoại 

+ Sử dụng phím chọn điểm để thay đổi tọa độ 
 

2.2.7. Xếp chồng các đối tƣợng Draw Order. 

Menu bar Nhập lệnh Toolbars 

Tool>Draw Order Draworder, DR Modify II 

 

Trong AutoCAD 2008 có mẫu mặt cắt dạng soild và hình ảnh raster… 

ngoài ra còn có các dòng chữ đƣợc tô, hình ảnh, các dạng mặt cắt… Các đối 

tƣợng này có thể nằm chồng lên nhau, do đó phải sắp xếp chúng theo một thứ tự 

nào đó. Các thứ tự có thể trƣớc, sau hoặc trên, dƣới. 

 Ví dụ Hình 2.23 bao gồm dòng chữ, mẫu mặt cắt dạng soild và stone. Ta 

sắp xếp chúng theo các vị trí nhƣ hình 2.23 bằng lệnh Draworder. 
 

 
Hình 2.23. Sắp xếp các đối tượng bằng lệnh Draworder 

Command: Draworder  (hoặc từ Tools menu chọn Display Order>) 

Select objects: (Chọn đối tượng) 

Select objects:  

Enter object ordering option [Above objects/Under objects/Front/Back] 

                         <Back>: sử dụng các lựa chọn 

Renegerating model: Nếu bạn chọn Above object hoặc Under object thì AutoCAD hiển 

thị dòng nhắc sau: 

Select reference objects: (Chọn đối tượng tham khảo) 

Các lựa chọn: 

+ Above object: Di chuyển đối tƣợng chon nằm trên đối tƣợng tham khảo 

+ Under object: Di chuyển đối tƣợng chọn nằm dƣới đối tƣợng tham khảo 

+ Front: Di chuyển đối tƣợng chọn đến trƣớc thứ tự bản vẽ 

+ Back: Di chuyển đối tƣợng chọn đến sau thứ tự bản vẽ 
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2.3. Block với thuộc tính:  

 Thuộc tính của block là những thông tin đƣợc gắn với block, đó là dòng 

chữ hoặc số đi kèm với block để mô tả block.  

 Một block có thể có nhiều thuộc tính. Thuộc tính là một thành phần của 

block. Khi chèn các Block này vào bản vẽ, AutoCAD yêu cầu gán các giá trị 

cho các biến này và nó xuất hiện cùng với các block đƣờng chèn. Ví dụ tạo 

block thống kê thanh thép với các thông số nhƣ hình 2.24. 

 
 

Hình 2.24. Ví dụ Block thanh thép có thuộc tính 

2.3.1. Lệnh Attdef 

 Lệnh Attdef dùng để tạo thuộc tính cho block. Thuộc tính là các dòng chữ 

chứa thông tin liên quan đến block. Định nghĩa thuộc tính mẫu (template) để tạo 

nên thuộc tính. Nó định các tính chất của thuộc tính và các dòng nhắc hiển thị 

khi chèn block với thuộc tính. 

 Đầu tiên ta nên vẽ các đối tƣợng của block, sau đó sử dụng lệnh Attdef  sẽ 

xuất hiện hộp thoại Attribute Definition.  

 Ta nhập lệnh nhƣ sau: 

 (1).  Pull down menu:    Draw > Block > Define Attributes. 

 (2).  Command line:    ATTDEF   

 Xuất hiện hộp thoại Attribute Definition. (Xem hình 2.25) 

 

 
 

Hình 2.25: Hộp thoại Attribute Definition. 
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 Trên hộp thoại Attribute Definition có các bảng sau: 

 - Mode: tạo các phƣơng thức của thuộc tính. 

 . Invisible: Nếu đánh dấu ở ô này thì khi chèn Block thuộc tính sẽ không 

hiện ra, làm tái hiện bản vẽ nhanh hơn. Sau đó, nếu muốn hiện ra thuộc tính ta 

dùng lệnh Attdisp. 

 . Constant: Giá trị thuộc tính sẽ không đổi khi ta chọn ô này. Khi đó ô soạn 

thảo Prompt trên vùng Attribute sẽ đƣợc ẩn đi. 

 . Verify: Nếu đánh dấu ở ô này thì khi nhập các thuộc tính vào dòng nhắc, 

AutoCad sẽ báo để ta kiểm tra lại. 

 . Preset: Nếu đánh dấu ở ô này thì AutoCad tự lấy giá trị mặc định. Sau đó, 

nếu muốn thay đổi giá trị thuộc tính ta dùng lệnh Attedit. 

 - Attribute: để gán các tham số của thuộc tính (tối đa 256 ký tự). Nếu 

muốn đặt khoảng trống ở đầu dòng mặc định thì nhập dấu gạch xuôi \.  

 . Tag: Nhập tên thẻ thuộc tính (Attribute Tag) không chứa khoảng trống và 

dấu chấm than (!). Tên thẻ thuộc tính sẽ hiện ra bên cạnh hình vẽ Block. 

 . Prompt: Nhập dòng nhắc thuộc tính và hiển thị khi ta chèn Block để ta 

nhập lại giá trị thuộc tính. 

 . Value: Nhập giá trị mặc định của thuộc tính. 

 - Insertion Point: Chọn điểm chèn bằng cách gõ toạ độ hoặc từ dòng nhắc 

(nếu đánh dấu ở ô Specify On-Screen). 

 - Text Options: Chọn kiểu canh lề (Jutification), kiểu chữ (Text Style), 

chiều cao chữ (Height), góc nghiên dòng chữ (Rotation).  

 - Align Below Previous Attribute Definition: Đặt thẻ thuộc tính ngay 

dƣới thuộc tính đã định nghĩa trƣớc đó. 

 

 Ví dụ tạo và chèn block có tên “thepdoc” với các thuộc tính nhƣ hình 2.26 

 
 

Hình 2.26. Ví dụ tạo Block thanh thép có thuộc tính 

2.3.2. Hiệu chỉnh block thuộc tính. 

 Lệnh Attedit hiệu chỉnh giá trị thuộc tính Block đã chèn vào bản vẽ.  

Ta nhập lệnh nhƣ sau: 

 (1).  Command line:    ATTEDIT (AT)  

 (2).  Toolbar:   Modify Toolbar >Nút Edit Attribute.  

 Select objects: Chọn đối tƣợng. 

 Select objects: Chọn đối tƣợng tiếp theo. 
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 Nhấn Enter để thực hiện lệnh. 

 
 

Hình 2.27. Ví dụ hiệu chỉnh block “thepdoc” 

 Để hiệu chỉnh thuộc tính block đã chèn vào bản vẽ, ta thực hiện nhƣ hình 2.28:  

 (1).  Fulldown menu:    Modify > Object > Attribute> Single 

 (2).  Toolbar:   Modify Toolbar >Nút Edit Attribute.  

 Select objects: Chọn block cần hiệu chỉnh. 

 Xuất hiện hộp thoại để hiệu chỉnh nhƣ hình 2.28. 

 

Hình 2.28. Gọi lệnh hiệu chỉnh thuộc tính block 

 

Hình 2.29. Hộp thoại để hiệu chỉnh thuộc tính block 

2.3.3. Lệnh Attedisp 

 Là lệnh điều khiển sự xuất hiện của các thuộc tính Block đã chèn vào bản 

vẽ.  

 Command line:   ATTEDISP  
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  Các lựa chọn nhƣ sau: 

- ON: luôn hiển thị thuộc tính và không phụ thuộc vào lựa chọn invisible 

của lệnh Attdef. 

- OFF: tất cả thuộc tính không hiển thị và không phụ thuộc vào lựa chọn 

invisible của lệnh Attdef. 

- Normal: thuộc tính đƣợc hiển thị và phụ thuộc vào lựa chọn invisible 

của lệnh Attdef. 

                    

a) OFF                                                               b) ON 

Hình 2.29. Lựa chọn hiển thị thuộc tính block “thepdoc” 
 

2.3.4. Lệnh Attsync 

 Là lệnh cập nhật những thay đổi sau khi hiệu chỉnh các thuộc tính của 

block cho những block đƣợc chỉ định.  

 Command line:   ATTSYNC 

 Các lựa chọn nhƣ sau: 

- ?: hiển thị danh sách tất cả định nghĩa block trên bản vẽ.  

- Name: nhập tên block mà bạn cần cập nhật 
 

2.4. Lệnh ghi nhóm đối tƣợng thành file - WBLock:  

Là lệnh ghi 1 nhóm đối tƣợng thành 1 file mới. 

Command line:   WBLOCK(W)> Hộp thoại Write Block. (Xem hình 2.30) 

 

 
                    a. Source: Block                                               b.Source: Objects 

Hình 2.30. Hộp thoại Write Block. 

 Các lựa chọn ở mục Source: 

 - Block: Ghi Block thành 1 File. Chọn vị trí cho File ở mục Destination. 
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 - Objects: Ghi một nhóm các đối tƣợng thành 1 File bản vẽ. Các lựa chọn 

ở ô Base point và Objects tƣơng tự nhƣ lệnh Block. Chọn vị trí cho File ở mục 

Destination. 

 Nhấn Ok để kết thúc lệnh. 
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CHƯƠNG 3: LÀM VIỆC VỚI DỮ LIỆU 

 Mục tiêu: giúp người học biết cách tạo ra một bản vẽ có sự liên kết với các 

bản vẽ khác. Đồng thời người học quản lý, hiệu chỉnh các dữ liệu trong một bản vẽ 

một cách nhanh chóng, dễ dàng. 

3.1. Giới thiệu về tham khảo ngoài:  

 Tham khảo ngoài là sự liên kết một bản vẽ bất kỳ (đƣợc gọi là bản vẽ chính) với 

một hay nhiều bản vẽ khác (gọi là bản vẽ xref – External references). Nếu ta chèn một 

bản vẽ vào trong một bản vẽ thì bản vẽ đƣợc chèn sẽ đƣợc định dạng là một Block và 

sẽ đƣợc lƣu cùng với bản vẽ chính. Nếu ta chỉnh bản vẽ đƣợc chèn thì block sẽ không 

đựơc cập nhật lại. Nếu ta chèn một bản vẽ vào trong nhiều bản vẽ khác dƣới dạng 

block thì việc cập nhật block khi block đó có vài sự thay đổi sẽ rất mất thời gian vì ta 

phải thay đổi lại các block trong tất cả các file đã chèn. 

 Những nhƣợc điểm trên sẽ đƣợc khắc phục thì ta dùng chức năng tham khảo 

ngoài của AutoCAD. Khi đó bản vẽ tham khảo sẽ đƣợc lƣu riêng, khi bản vẽ tham 

khảo thay đổi thì tất cả các bản vẽ tham khảo đến nó sẽ tự động thay đổi theo. Việc 

dùng tham khảo ngoài rất hữu ích khi làm việc với những dự án lớn. Đặc biệt là khi ta 

chia sẻ tài nguyên bản vẽ trên mạng. 

3.2. Chèn một xref vào bản vẽ:  

3.2.1. Lệnh Xattach 

 Lệnh Xattach cho phép ta chèn một bản vẽ vào bản vẽ chính dƣới dạng tham 

khảo ngoài. 

 Command : Xattach 

 
 

 Hình 3.1: Hộp thoại khi thực hiện lệnh Xattach . 
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Hộp thoại Select reference file hiện lên (hình 3.1). Ta chọn file cần chèn vào 

bản vẽ chính. Sau đó chọn Open, hộp thoại External Reference hiện lên (hình 3.2). 

 

Hình 3.2. Hộp thoại External Reference. 
 

Browse: thay đổi bản vẽ chèn vào. 

Found in: đƣờng dẫn của bản vẽ xref. 

Path type: quy định kiểu đƣờng dẫn là tuyệt đối hay tƣơng đối, hay không kèm 

theo đƣờng dẫn. Các lựa chọn này quy định Save path. Bạn đọc có thể kiểm tra kết quả 

của từng lựa chọn của mình trong Save path. 

Reference Type: kiểu chèn 

: cho phép hiển thị các xref lồng nhau. 

: không cho phép hiển thị các xref lồng nhau. 

Các lựa chọn về Intertion Point, Scale và Rotation tƣơng tự nhƣ lệnh insert. 
 

3.2.2. Lệnh Xref 

 Lệnh Xattach cho phép ta chèn một bản vẽ vào bản vẽ chính dƣới dạng tham 

khảo ngoài. 

 Command: Xattach 

 Hộp thoại quản lý lệnh Xref (Xref Manager) nhƣ 

hình 3.3 

  Nút Tree View cho phép ta nhìn cấu trúc cây của 

Xref. Danh sách đƣợc liệt kê theo bảng chữ cái. Các Xref 

lồng đƣợc sắp xếp theo mức độ lồng (hình cây). 
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Hình 3.3. Hộp thoại Xref Manager. 

 

 

thoại External Reference hiện lên (nhƣ đã trình bày ở trên). 

  

 ile xref vừa có sự thay đổi 

 

vẫn lƣu lại đƣờng dẫn của file xref. Nếu ta muốn đọc lại file này chỉ việc ấn vào nút 

Reload. 

 : Quy định sự ràng buộc của xref với bản vẽ chính. Bấm vào hộp thoại sẽ 

hiện lên (hình 2.4) 

 : mở file xref trong một cửa sổ mới, tƣơng đƣơng với lệnh Xopen. Ta có 

thể thay đổi file xref, sau đó quay lại bản vẽ chính để cập nhật lai (reload trong hộp 

thoại Xref Manager) sự thay đổi của bản vẽ xref. 

  Thay đổi file bằng nút Browse. Sau đó nhấn Save path đề ghi lại đƣờng dẫn 

 Khi bấm vào nút Xbind của hộp thoại Xref Manager thì hộp thoại Bind Xrefs 

hiện lên nhƣ sau (phần này cũng tƣơng đƣơng với việc dùng lệnh Xbind): 

 : các đối tƣợng của bản vẽ xref sẽ đƣợc nối tiếp vào bản vẽ chính 

 : các đối tƣợng của bản vẽ tham khảo sẽ không là thành phần của bản vẽ 

chính. 

 
Hình 3.4. Hộp thoại Blind Xref. 

 

3.3. Mở một Xref từ bản vẽ chính:  

Lệnh Xopen cho phép ta mở một Xref ra một cửa sổ riêng. 

Command: Xopen 
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Select Xref: chọn Xref để mở ra cửa sổ riêng 

Chọn file Xref trong hộp thoại External Reference sau đó chọn Open. 

3.4. Hiệu chỉnh Xref từ bản vẽ chính:  

 Từ phiên bản AutoCAD 2002 cho phép ta sửa file Xref ngay trên bản vẽ chính 

sau đó lƣu trở lại (Save back). 

3.4.1. Lệnh Refedit (Reference Edit). 

 Identify reference 

 Reference name: Chọn tên xref cần sửa, sơ đồ cây sẽ thể hiện cả các reference 

lồng nhau. Lƣu ý là mỗi lần ta chỉ sửa đƣợc một xref, nếu ta chọn xref (VD drawing 1 

nhƣ hình vẽ) chứa xref lồng (drawing 2) để sửa thì ta cũng chỉ sửa đƣợc xref chứa xref 

lồng (drawing 1) chứ không sửa đƣợc xref lồng (drawing 2). Do vậy muốn sửa xref 

nào ta chọn xref đó để sửa (hình 2.5). 

 Path: Hiển thị đƣờng dẫn của xref mà ta chọn. 

 Automaticlly select all nested objects: tất cả các objects trong file xref sẽ đƣợc 

chọn. 

 Prompt to select nested objects: kích hoạt chế độ chọn các object trong file tham 

khảo mà bạn muốn sửa. 

 
Hình 3.5. Hộp thoại Reference Edit . 

  

 Setting (hình 3.6) 

 Create unique layer, style, and block names : 

 

cả các object trong file tham khảo sẽ nằm trong layer này. 

 

bình thƣờng. 

 Display attribute definitions for editing: Nếu chọn thì các thuộc tính sẽ đƣợc hiển 

thị và ta có thể sửa chúng, sau khi ta ghi lại thì các thuộc tính trong bản vẽ gốc sẽ thay 

đổi theo, các thay đổi chỉ đƣợc thể thiện ra khi ta chèn các thuộc tính đã sửa ra bản vẽ. 

 Lock objects not in working set : Nếu chọn chế độ này thì tất cả các object của 

bản vẽ chính sẽ bị khóa lại, chúng ta không thể hiệu chỉnh đƣợc chúng. 
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 Khi tạo sửa một file tham khảo ngoài thì các đối tƣợng khác mà ta không chọn 

để sửa sẽ mờ đi. Tuy nhiên nó chỉ mờ đi khi biến shademode đƣợc đặt là 2D 

wireframe. 

 Command: Shademode 

 Current mode: 2D wireframe 

 Enter option [2D wireframe/3D 

wireframe/Hidden/Flat/Gouraud/fLat+edges/gOuraud+edges] <2D wireframe>: 2D 

 

 
Hình 3.6. Hộp thoại Setting. 

 

3.4.2. Thêm, bớt đối tƣợng từ Working set 

 Command: refset 

 Transfer objects between the RefEdit working set and host drawing... 

 Enter an option [Add/Remove] <Add>: a (chọn thêm hay bỏ bớt đối tƣợng) 

 Select objects: Specify opposite corner: 1 found 

 Select objects: Enter 

 1 Added to working set 

3.4.3. Lƣu các thay đổi sau khi hiệu chỉnh 

 Sau khi hiệu chỉnh có thể ghi lại hoặc không ghi các thay đổi bằng lệnh Refclose 

 Command: refclose 

 The following symbols will be added to Xref file: 

 Blocks: chọn tên đối tƣợng thêm vào 

 Enter option [Save/Discard reference changes] <Save>: s 

 Regenerating model. 

 2 objects added to test 

 1 xref instance updated 

 test redefined and reloaded 

 Enter option : 
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 d reference changes : không ghi lại sự thay đổi. 

 Nếu bạn chọn chế độ ghi lại, xref sẽ tự động reload lại. Đây là sự khác biệt giữa 

lệnh Xopen và lệnh Refedit. 

3.5. Lọc dữ liệu:  

3.5.1. Lệnh Filter (lọc dữ liệu). 

 Lệnh Filter 

 Đây là một lệnh bổ trợ rất nhiều trong quá trình chỉnh sửa bản vẽ. Nó giúp lọc 

các đối tƣợng cần chọn một cách nhanh nhất. 

 Command: Gõ lệnh FI < Enter > 

 Trên màn hình hiển thị hộp thoại Objects selection (hình 3.7) 

 

 
 

Hình 3.7. Hộp thoại chọn đối tượng để lọc. 

 

 Ví dụ bạn muốn xóa tất cả các đƣờng kích thƣớc chẳng hạn, quy trình làm nhƣ 

sau: 

 + Trong mục Select filter bạn ấn vào nút tam giác và chọn Layer (vì tất cả nét 

kích thƣớc đƣợc vẽ bằng lớp Kich thuoc) 

 + Sau khi chọn layer bạn nhấn trái chuột vào nút Select, hiển thị lên tên tất cả các 

lớp đã đƣợc khai báo trong bản vẽ. Bạn kéo con trỏ xuống và ấn trái chuột vào Kich 

thuoc, rồi nhấn Ok. 

 + Quay lai cửa sổ Objects selection, bạn ấn trái chuột vào nút Add to list, sẽ thấy 

dòng “ Layer = Kich thƣớc ” ở phía trên (kết thúc việc chọn đối tƣợng để lọc). 

 + Tiếp theo đến quá trình lọc đối tƣợng: Ấn trái chuột vào nút Apply ở góc dƣới 

bên phải nó hiện ra một ô vuông còn dƣới dòng lệnh hiển thị câu nhắc “>>Select 

Objects = Chọn đối tƣợng” Các bạn cần chọn vùng lọc đối tƣợng. Nhƣ hình dƣới vùng 

chọn chính là hình chữ nhật màu trắng. Khi đó tất cả đối tƣợng có đƣợc vẽ bằng lớp 

Kich thuoc sẽ đƣợc chọn. 

 + Dƣới dòng lệnh vẫn hiển thị Select Objects: Bạn ấn Enter 2 lần liên tiếp thực 

hiện lệnh xóa tất cả các đối tƣợng lớp Kich thuoc. 

3.5.2. Lệnh Find (tìm và thay thế dữ liệu). 

 Lệnh Find 
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 Đây là một lệnh giúp tìm và thay thế hàng loạt các đối tƣợng có cùng thuộc tính. 

 Command: Gõ lệnh Find < Enter > 

 Trên màn hình hiển thị hộp thoại Objects selection (hình 3.8) 

 

 
    

Hình 3.8. Hộp thoại để tìm và thay thế đối tượng. 
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CHƯƠNG 4: ỨNG DỤNG AUTO LISP TRONG XÂY DỰNG 

 

 Mục tiêu: giúp người học làm quen AutoLisp trong môn trường AutoCAD, đồng 

thời sử dụng được một số Lisp đơn giản sẵn có dành cho bản vẽ kỹ thuật xây dựng. 

4.1. Giới thiệu 

LISP lµ ch÷ viÕt t¾t cña côm tõ tiÕng Anh: LISt Processor (Xö lý danh s¸ch) 

AutoLisp lµ mét øng dông cña ng«n ng÷ Lisp ®­îc sö dông trong m«i tr­êng 

AutoCad. LISP lµ ng«n ng÷ lËp tr×nh thuéc nhãm trÝ tuÖ nh©n t¹o do MacCarthy so¹n 

th¶o cuèi nh÷ng n¨m 50. Víi AutoLisp ng­êi dïng cã thÓ më réng vµ tuú biÕn c¸c 

chøc n¨ng cña AutoCad.  

HiÖn nay AutoLisp ®· ®­îc h·ng Autodesk ph¸t triÓn theo c¸c sè hiÖu ph¸t 

hµnh cña AutoCad. VÒ c¨n b¶n nh÷ng phiªn b¶n sau vÉn sö dông ®­îc nh÷ng ch­¬ng 

tr×nh lËp b»ng phiªn b¶n tr­íc, ng­îc l¹i th× kh«ng ®­îc do cã mét sè biÕn hÖ thèng vµ 

lÖnh cña AutoCad gi÷a c¸c phiªn b¶n kh«ng gièng nhau nªn viÖc dïng chung cã gÆp 

mét sè trë ng¹i. Do vËy yªu cÇu ng­êi lËp tr×nh AutoLisp ph¶i n¾m thËt v÷ng AutoCad 

®Ó sö dông AutoLisp mét c¸ch hiÖu qu¶. 

AutoLisp lµ mét ng«n ng÷ lËp tr×nh th«ng dÞch, nghÜa lµ dÞch ®Õn dßng nµo thùc 

hiÖn dßng ®ã vµ cho kÕt qu¶, kh«ng cã tr×nh biªn dÞch riªng. Mét tËp hîp c¸c c©u lÖnh 

cña AutoLisp ®­îc gäi lµ hµm Lisp vµ tÖp (file) chøa c¸c hµm gäi lµ tÖp (file) Lisp cã 

phÇn më réng lµ *.Lsp. 

 Víi AutoLisp, ng­êi dïng cã thÓ dÔ dµng truy cËp ®Õn d÷ liÖu cña AutoCad, cã 
thÓ thay ®æi, t¹o míi, xo¸ bá c¸c ®èi t­îng, thªm c¸c th«ng tin vµo b¶n vÏ thùc hiÖn 
c¸c c«ng viÖc Tù ®éng ho¸ trong thiÕt kÕ...  

4.2. Tải và chạy ứng dụng Auto Lisp  

Tõ VLISP: Tools\ Load Text in Editor 

Tõ AutoCad: Tool\ Load Application hoÆc trªn dßng lÖnh Command: ap 

§Ó AutoCad tù ®éng t¶i ngay tõ khi khëi ®éng hoÆc më b¶n vÏ cã 2 c¸ch: 

- §Æt tªn tÖp lµ ACAD.LSP vµ ®Æt trong th­ môc Support cña AutoCad 

- Khi t¶i file lÇn ®Çu sö dông Startup Suite\ Contents vµ chän ®­êng dÉn cho 

file 

4.3. Một số LISP cho bản vẽ xây dựng  
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Hình 4.1. Lisp cho bản vẽ kiến trúc nhà. 
 

 

 

 
 

Hình 4.2. Lisp cho bản vẽ kết cấu nhà. 
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